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Advanced Microsoft Excel 2013  

Introduction 
Microsoft Excel is program designed to efficiently manage spreadsheets and analyze 

data. It contains both basic and advanced features that anyone can learn. Once some 

basic features are known, learning the advanced tools becomes easy. This lesson is 

composed of some advanced Excel features. It assumes basic prior knowledge of Excel, 

and it is expected that the objectives from AT Step’s Excel Essentials are known. This 

lesson will talk about the advanced customization and formatting features that allow 

for easier data manipulation and organization. 

Objectives 
1) Learn how to Customize the Interface 

2) Advanced Formatting: Custom Lists, Cell Groups, and Transposing Tables 

3) Learn how to Reference Across Sheets 

4) Advanced Formulas and Using Data Ranges 

5) Using Data Validation  
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Interface Customization 

Most of Excels interface can be customized to fit many people’s needs.  For some, 

customization makes tools more readily available by placing those tools in a location 

that is more natural for the user.  This section will introduce you to customizing Excel’s 

interface by adding a tab in the ribbon, customizing the status bar at the bottom of the 

program, opening separate panes, and scrolling through a sheet with a static column or 

row. 

Adding a Tab in the Ribbon 

In this subsection, we will explore the tab options in Excel. Tabs in Excel can be added, 

deleted and even reorganized. This feature is useful if you use a set of tools frequently 

as it can save time navigating between tabs.  

1. Download and unzip the Exercise files from the At Lab’s website.  

2. Open Excel and choose the blank workbook. 

 

A recent change in Excel is the startup screen. In the past, Excel defaulted to opening a 

blank workbook. Now, you have the option of choosing a blank workbook, template, or 

previously created file. 
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3. Open backstage view by clicking on the File Tab and choose ‘Options’. This 

will open the Options dialog box.  

4. Select ‘Customize Ribbon’. This tab allows you to add tabs as well as move tabs 

around.

 

Notice that this box has two main sections. The first is an area which displays the 

commands which can be added to tabs. At the top of this section, there is a drop-down 

menu allowing you to choose the type of command from the list shown below. Select 

macros from this list. Here there are no commands because we have not created any 

macros yet. If you use macros, you can add them to your custom tab or group after you 

create them.  
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5. Click Home under the main tabs and click ‘New Tab’. 

 

A new tab labeled “New Tab” along with a new group labeled “New Group” is placed 

under the Home tab. From here you can re-name the tab and group, add more groups, 

and add actions in each group. 

6. Rename the tab to “Yourname’s Tab” by selecting the tab and choosing 

‘Rename’ at the bottom of the ‘Main Tabs’ section. 

A dialog box displaying an editable field is displayed. This tool can be used not only to 

rename your custom tab, but also any tab that is in the worksheet. 

7. Click OK to accept the new name. 

8. Rename the new group to “Other Formatting Tools”. 

Notice the dialog for renaming a group looks different because it allows you to add 

symbols to the name. 

  

The field at the bottom of this dialog box is where the name can be edited. 

For now, we will be adding formatting tools to this group. 
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9. Click Ok to accept this name for the group. 

10. Add the ‘Format Cells…’ tool to your group by selecting the tool in the 

command window and clicking ‘Add’. 

 

 

 

 

Notice that when a tool is added to a group, it is removed from the command choices. 

11. Click on ‘Formatting Tools (custom)’ and click ‘New Group’ to add a new 

group to your tab. 

12. Rename this group to “Image Tools”. 

We will be adding some tools that not already in the ribbon here. 
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13. Select ‘Commands Not in the Ribbon’ from the commands drop down menu 

and add the ‘As Picture’, ‘Camera’, ‘Image(ActiveXControl)’, ‘Less Brightness’, 

and ‘Less Contrast’ tools into the ‘Image Tools’ group. 

 

      

14. Click and drag your tab to before ‘Home’.  

In the ribbon, the tabs are displayed in the same order as in the ‘Customize Ribbon’ 

dialog box, so this will place your tab as the first tab after the file tab. 
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15. Click ‘Ok’ to exit the ‘Customize Ribbon’ dialog box and click on your custom 

tab. 

Your tab should look similar to the following picture. 

 

 

Now that you have a customized ribbon, you can quickly get to the tools you need most 

often. Your options for creating ribbons are nearly limitless. Another part of Excel that 

can be easily customized is the status bar. 

Status Bar Customization 

At the bottom of every Microsoft Office program, there is a status bar. This bar, by 

default, contains different viewing options as well as the zoom slider. Excel allows you 

to add and take away features on the status bar such as the ability to display the sum, 

average, and other calculations for a selected data range.  

1. Open a new worksheet and observe the status bar. 

 

On the right hand side of the toolbar, the view slider, the Page Break preview, Page 

Layout, and normal View options are displayed. On the left, the word ‘Ready’ is shown. 

Ready is part of the cell mode option that indicates a general state. The other modes are 

enter, indicating content is being entered into the cell, edit, indicating content is being 

entered into the formula bar for a cell, and point, indicating that a data range is being 

selected for referencing. 

2. Right click on the status bar to see the different options available. 
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There are different options such as information about the mode, calculations that can be 

displayed, and viewing tools. We will explore some of these options in the following steps. 

3. Ensure that Average, Count, Minimum, Maximum, Sum, Num Lock are selected. 

Before any data is typed, the status bar is already displaying Num Lock on the left side to 

indicate that the Num Lock is on.  

 

4. Enter the numbers 1-12 in A1:A12. 

We will look at some different calculations of these numbers in the status bar. 

5. Select cells A1:A12. 

Notice the status bar now displays all of the calculations that were selected. This can be 

used whenever it is useful to know the average, sum, etc. but not necessary to display 

that information in the sheet.  

 

 

Once the status bar is customized, we can analyze data quickly without having to put 

certain formulas into the sheet. We also can add the information about the sheet or even 

whether a key on the keyboard is active. Another time-saving feature that Excel has is 

the ability to navigate in panes.  
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Navigating in Multiple Windows and Panes 

When working with multiple worksheets, navigating through each sheet can be an 

annoyance as well as cost valuable time. On the other hand using window views allows 

you to navigate in multiple workbooks at the same time. You can also split one 

workbook into 4 different views or open the same worksheet multiple times. We will 

explore these features now.  

1. Close Excel. 

In the past, Excel was able to run regardless of whether a workbook was open or not. In 

2013, Excel started handling each workbook as its own instance of the program. 

2. Navigate to the ‘Exercise Files’ folder. 

3. Open the Divisional_Sales, Quarterly Sales by Division, Yearly_sales, and 

Units_per_Customer workbooks. 

 

We will use different viewing options to display more than one of these sheets neatly on 

the screen at once. Excel gives a few different ways of doing this, and we will look at a 

couple of those ways. 

4. Click on the ‘Restored Down’ button between ‘Minimize’ and ‘Close’. 

 

Notice that you can see two windows of Excel open, and each Window contains all of the 

tools and functions in Excel. As mentioned before, each workbook used to be a part of the 

program, now, the program is open inside each workbook. This is useful when arranging 

multiple worksheets because different tabs on the ribbon can be opened in each workbook. 
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5. Navigate to the Window group in the View tab.  

 

Here are the tools that we will use to arrange the workbook windows. Later, we will be 

using the Freeze Panes drop down menu, but for now we will use the New Window, 

Arrange all, Split, Hide, View Side by Side, Synchronous Scrolling, and Rest Window 

Position tools. 

6. Click Arrange all. 

Notice a dialog box is displayed giving a few different displaying options. We will explore 

each of these options. 
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7. Choose Tiled and click OK. 

Tiled shows the workbooks in equally sized squares with one taking two spaces on the left 

if there are an odd number of windows. This is great for easy comparison of data in 

different windows. 

 

  



AT Computer Labs 

8. Click Arrange All and choose Horizontal. 

This aligns the windows one on top of the other with each workbook as wide as the 

program’s window with each having the same height as the rest. This choice is useful if 

you want to compare rows in different workbooks. 

 

The ribbon is not shown in any workbook. The ribbon will only be shown if there are less 

than three workbooks opened. 

9. Restore one of the instances to make the ribbon reappear. 
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10. Choose the Vertical option in the Arrange All dialog box. 

The workbooks are now aligned next to each other so that they are all as tall as the 

program and all have the same width. This allows you to compare columns from multiple 

workbooks easily.  

 

11. Choose the Window drop-down to display the window group. 
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12. For a final time, choose Arrange All and select the Cascade option. 

This places the active workbook in the front with the other workbooks cascaded behind it. 

This allows you to easily move between books one at a time while still given you a large 

viewing window for each book. 
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13. Click the Quarterly Sales by Division workbook and then, click View Side by 

Side. 

A dialog box asking you to choose another workbook is displayed. This tool only allows 

viewing of two workbooks at once and by default is similar to the Horizontal Arrange All 

tool. If multiple windows were arranged just before this tool was used, the tool will 

sometimes try to match the other windows arrangement. 

 

14. Choose the Divisional_Sales workbook. 

Your window should look like the following image. 
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If the window does not look like this, choosing  will positions the 

windows correctly. 

15. Observe that Synchronous Scrolling is highlighted and scroll down a worksheet. 

 

When it is useful to be able to scroll through the two workbooks simultaneously, this tool 

allows that ability. If the button is not highlighted, the sheets will not scroll together. 

16. Click Hide. 

This hides the active window. If pressed multiple times, it will continue hiding windows 

until all the windows are hidden. 

17. Click hide again until there are no worksheets displayed. 

Notice only the program is running, and no worksheet is showing. 
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18. Click Unhide. 

A dialog box showing the hidden workbooks is displayed. 

 

19. Choose the Divisional_Sales.xlsx workbook and click ‘OK’. 

20. Click New Window. 

 

A new window display a copy of the active workbook is displayed. The New window 

button can be used multiple times to add multiple windows of the same workbook. Each 

window is titled with the workbooks name followed by a colon and a number. 
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21. Arrange the windows side-by-side. 

22. Type “1234” into cell A1 of Divisional_Sales.xlsx:2 

When something is done to one window of a worksheet, the changes are displayed in all of 

the windows of the worksheet.  

 

 

23. In the top window, click into the North Division – January sheet.  

These two sheets can now be compared without switching between sheets in the same 

window. 

 

We have just looked at how to view multiple workbooks and sheets simultaneously in 

Excel. With this information, using multiple workbooks or sheets at the same time 

becomes less of a task. Excel also allows the ability to split one window into multiple 

sections called panes which we will look at in the next section. 
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Using a Static Column or Row 

Static columns and rows involve the use of panes. A pane is a divided section of a 

worksheet in the same window. When a window is divided into panes, scrolling 

comparing parts of the same worksheet becomes easier. We will look at different ways 

to display panes. 

1. Close all but the ‘Units_per_Customer.xlsx’ workbook and maximize the 

workbook. 

This workbook contains information that is spread over many columns and rows. To view 

different parts of this sheet, will use the split tool. 

2. Click Split in the Window group on the View tab.  

Excel splits this worksheet into 4 panes with a gray border between each pane. Each pane 

is equally sized, but you can adjust the borders if needed. By default, each pane shows a 

different part of the worksheet.  

 

3. Scroll up and down in the top half of the screen. 

The top panes both scroll vertically together and the bottom panes scroll vertically 

together.  

4. Scroll left and right in the right half of the screen. 

Similar to vertical scrolling, the left and right halves of the screen scroll horizontally 

together. 
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5. Click into any other sheet. 

Notice that only the first sheet is split into panes. Each sheet can be split into panes at 

any time by navigating to the sheet and clicking Split. 

6. Navigate back into sheet 1 and click Split a second time. 

This brings the window back to the original view. A sheet will remain in the split view 

until Split is clicked and second time. Another way of using panes is by freezing the 

panes. 

7. Click into cell A1. 

8. Click Freeze Panes. 

A menu giving three options is shown. Each of these options creates a set of panes and 

freezes one of the panes to allow for easy viewing of data from one part of the sheet with 

the frozen pane. 
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9. Choose the first option, ‘Freeze Panes’. 

 

This option adds in panes that are split with a thin black line. Here, the top-left pane is 

locked from scrolling, the bottom panes only scroll up and down, and the right panes only 

scroll left and right. This allows you freeze the set of data that is shown first sheet while 

scrolling left, right, u, and down through the rest of the sheet. Freeze Top Row keeps the 

top row static while scrolling vertically through the sheet, and Freeze First Column keeps 

the first row static while scrolling left and right through the sheet. 

10. Click Freeze panes and choose ‘Unfreeze Panes’. 

Anytime you have panes frozen, this option will unfreeze the panes and restore the sheet 

to the default view. You can also adjust where you want the top pane placed. 
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11. Select cell L23 and Freeze the panes a second time.  

Notice this time, the first pane is now larger than before. Anytime a cell other than A1 is 

selected, the panes are positioned so that the last selected cells are not in the static frame. 

 

12. Unfreeze the panes, select Row 8, and refreeze the panes. 

Now, the frozen pane is simply the top seven rows with the selected row just out of the 

static pane. 
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13. Unfreeze the panes, select column C, and refreeze the panes. 

Here, columns A and B are static while the selected column is just out of the range. We 

will briefly look at freezing just the top row or left column. 

 

14. Unfreeze the panes and choose ‘Freeze Top Row” in the freeze panes menu. 

15. Scroll down the page. 

Here the top pane is static. This allows easier data entry in the table. It also allows 

information on specific people to be accessed easier. 
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16. Now choose Freeze ‘First Column’. 

This time, the first column is the only static pane. 

 

17. Unfreeze the panes and close this workbook. 

 

When it is necessary to navigate within large worksheets, workbooks, or multiple 

worksheets and workbooks, using windows can save time from switching between 

sheets and books as well as from scrolling back and forth from one part of the sheet to 

another. In the next section, we will see how referencing across sheets can also save 

time. 
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Referencing Across Sheets 

Anytime a cell is used in another part of a workbook or worksheet, the cell is said to be 

referenced to that part. An example is when a formula references a range of cells. In AT 

Steps Excel Essentials lesson, referencing is introduced within one worksheet. Here, 

referencing will be explored across multiple worksheets in a workbook and even across 

multiple workbooks.  

1. Open the Divisional_Sales.xlsx worksheet.  

This worksheet contains divisional sales for a fictitious company. The first four sheets 

have information on the sales in each state. We will be entering formulas for Excel to 

place the totals inside one sheet. 
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2. Navigate to the January Totals worksheet.  

This sheet is formatted to display the divisional total sales and then overall totals at the 

bottom of the sheet.

 

3. Click into cell B3. 

Here we want to display the total units sold from the ‘South Division – January’ 

worksheet. This could be done by copying that data directly to the totals sheet, but if the 

data is changed in the original sheet, the changes would not be reflected in the totals 

sheet. The solution to this problem would be to relatively reference cell A13 from the 

original worksheet. 

4. Type “=(“.  

 

This tells Excel that you will be referencing another cell. At this point we could type 

“‘South Division – January’!E13” to designate the cell, but it would be faster to go 

directly to the ‘South Division – January’ worksheet. 
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5. Navigate to the worksheet labeled ‘South Division – January’ and choose cell 

E13. 

Notice the formula bar now displays “=(‘South Division – January’!E13” This is how 

Excel labels cells from other worksheets in the same workbook. 

 

6. Type ‘)’ and press enter. 

‘January Totals’ is now the active worksheet, and the data displayed in cell B3 is identical 

to the data in cell E13 on the South Division – January worksheet.  

7. Change the data in cell E13 on the South Division – January worksheet and refer 

back to the January Totals sheet. 

Here, the data has changed to match what is displayed in the worksheet you are 

referencing.  

8. Press Undo to undo the change of data in cell E13 on the ‘South Division – 

January’ worksheet. 
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9. Repeat steps 3-6 for cells B4:B6 in the Totals sheet using the data from the rest of 

the sheets respectively. 

At the end of this step, your sheet should look like the following picture: 

 

We now want to total the units sold from all of the divisions which could be done using 

‘=sum(B3:B6)’ in the January Totals sheet; however to see how to use a formula from 

multiple worksheets, we will some the data from cell E13 in each worksheet. 

10. Type ”=sum(“ into cell B7 in the Totals sheet.  

We will use this formula to sum the totals in E13 from each sheet. 

 

11. Click into the first worksheet and click cell E13. 
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12. Now hold ‘shift’ and click on the worksheet just before the totals sheet. 

Notice the status bar now displays “=SUM('South Division - January: West Division - 

January'!E13”. This can be broken into two parts. The first part is “'South Division - 

January: West Division - January'!” which  tells Excel that we are referencing cells from 

all of the sheets between ‘South Division – January’ and ‘West Division – January’ 

should sheets be moved so that there are more sheets between these sheets, excel will 

update the formula to include the additional sheets. The second part, “E13”, tells Excel 

which specific cells are referenced inside the range of worksheets. 

 

13. Type ‘)’ and press enter. 

‘January Totals’ is again the active sheet, and now cell B7 now contains the total from 

E13 in the other sheets.  
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14. Continue referencing the appropriate cells for the rest of this table. 

To practice referencing multiple sheets in a specific cell, use cells F13 and G13 in the 

other sheets for cells C7 and D7 in the ‘January Totals’ worksheet respectively. Your 

‘January Totals’ worksheet should now look like the following picture. 

 

15. Open the Yearly_sales.xlsx workbook and display the two workbooks side-by-

side. 

This sheet contains the yearly totals based on the month. We want to reference the totals 

in the ‘Divisional_Sales’ workbook.  

16. Type ‘=(‘ into cell B3 on the ‘2012 Sales’ worksheet.  

17. Now click into cell B7 on the ‘January Totals’. 

 

This worksheet is in the ‘Divisional_Sales’ workbook. The formula bar now reads 

“=('[Divisional_Sales.xlsx]January Totals'!$B$7” indicating that it is using absolute 

referencing from cell B7. Notice that Excel now also references the file name including 

the .xlsx.It is important to keep the files being referenced in the same folder as the file 

doing the referencing. Excel automatically creates this as an absolute reference whenever 

a cell is referenced from another workbook, but you can change that referencing to be 

relative.  



AT Computer Labs 

18. Type ‘)’ and press enter to return to the original workbook.  

We want to drag this reference through the rest of the row, but we want to change the 

reference from an absolute reference to a relative reference.  

19. Click into cell B3 and then into the formula bar.  

20. Remove the ‘$’ from “=('[Divisional_Sales.xlsx]January Totals'!$B$7)”. 

Now that we have a relative reference, we can drag this through the rest of the row which 

will fill in the rest of the information with respect to the ‘January Totals’ sheet.  

21. Drag the reference through the row. 

The values in cells C3 and D3 now correspond to cells C7 and B7 in the ‘January Totals’ 

sheet.  

 

 

 

In this section, we explored relative referencing across sheets and workbooks. We also 

saw that one cell can reference more than one sheet. In the next section we will see some 

formatting features that also involved multiple sheets. 
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Advanced Formatting 

Excel has many quick and basic formatting features, but sometimes more customization 

is needed. We will use features that format things in the program itself to be used in 

multiple workbooks as well as worksheets in specific workbooks. In this section, we 

will explore some advanced formatting features such as creating a custom list and 

formatting across groups of worksheets.  

Custom Lists 

We will start by adding a custom list. Custom lists allow you to work with lists that are 

either lengthy, used frequently, or both. Once created, a custom list stays in the 

program which allows the use of the list in multiple workbooks. Using this feature, you 

will only have to enter the list once. When you want to use the list later, Excel can 

populate the list for you. 

1. Open a new worksheet.  

2. Open the ‘Options’ dialog box. 

3. Navigate to the general section of the ‘Advanced’ tab. 

Choose Advanced on the left of the ‘Options’ screen and scroll to the section labeled 

general on the right. 
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4. Navigate to the ‘Custom Lists’ dialog box. 

Click the button labeled ‘Edit Custom Lists…’ The Custom Lists dialog box is now 

displayed. Here, you can enter your list in two different ways. You can add it using the 

‘New List’ option, or you can select a data range where your list is already populated.  

 

5. Click ‘New List’. 

6. Create a new list representing the seasons using fall as opposed to autumn: 
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With ‘New List’ highlighted, click into the ‘List entries:’ text area and type the names of 

the seasons. 

7. Type “Winter, Summer, Spring, Fall”. 

 

 

8. Click ‘Add’ to add the list. 

9. Click ‘Ok’ to exit the Custom Lists dialog box and ‘Ok’ again to exit the ‘Options’ 

dialog box. 

10. Populate the list into cells A1:A4 

Type ‘winter’ or any other part of the list in cell A1.Move your cursor to the bottom right 

hand corner of the cell until it changes to a small bold +.Hold and drag the cursor until 

you see the entire list in the column. Now that the list is populated, you can organize 

using Excel’s sorting features. For now, we will edit the list to ensure that autumn, 

instead of fall, is in the list. 
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11. Remove fall and add autumn to the seasons list. 

Reopen the ‘Custom Lists’ dialog box. Select the list containing the seasons. Delete fall 

and type autumn. 

 

12. Click add to update the list. 

13. Populate the edited list into cells A6:A9. 

In this new list you can see that autumn is entered instead of fall. In the same way, you 

can edit any list through the ‘Custom Lists’ dialog box. 

 

Now that you know how to create a list from scratch and edit a preexisting list, we are going to 

learn how to create a list from a list that is already in a worksheet. 
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14. In cells B1:B10 type ten colors. 

15. Reopen the ‘Custom Lists’ dialog box. 

16. Select cells B1:B10 to create a list. 

 

17. Click ‘Import’. 

You will now see your list in the ‘List entries’ text box. 

 

18. Click Ok and populate the list in column C. 
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Now that you know how to work with custom lists, you can easily enter lists without typing 

each entry multiple times. These lists are not saved with the file, so if use multiple computers, the 

list will have to be created on each computer, but since you can create a list from a data range, 

you can simply create the list in one file and recreate the list on each computer you use. 

Using Groups to Format Multiple Worksheets 

Another advanced formatting feature Excel 2010 has is formatting over a group of 

worksheets. This is useful if you have many different sheets that you want to be 

identically formatted. The formatting can be done over as few as two sheets in a 

workbook to as many as are in the workbook. Using this feature, you can format cells in 

basic ways such as shading, manually creating a table, or inserting formulas. 

Unfortunately, you do not have the option of using conditional formatting or 

formatting the cells as a table. 

1. Open the Courses_by_Semester.xlsx worksheet. 

Notice that this workbook is composed of worksheets that are labeled by the semester. We 

are going to format this sheet as a sample class schedule. 

 
2. Select all of the Worksheets. 

Select the sheet labeled ‘Fall 12’, press shift, and click on the sheet labeled ‘Summer 14’. 

The sheets are now a group of worksheets. You can also do this by right clicking any sheet 

and selecting ‘Select All Sheets’. 

  

 

 

 



AT Computer Labs 

3. Format a table in cells A1:C7 similar the one in the picture below. 

Type Course, Meeting Times, and Credits in the top row of the first sheet as in the 

following picture. Apply all borders to the table, and enter a formula to sum cells C2:C6 

in C7. Resize all of the columns to fit so that all of the information is displayed. 

 

4. Click into another worksheets. 

You will notice that each worksheet is formatted in exactly the same way. When 

formatting over multiple sheets, you want to be careful because if you delete or edit data 

in cell C1 in one worksheet, it will be deleted or edited in all of the worksheets. We will 

see an example of this now. 

5. Reselect all sheets. 

6. Type “January” into A10 and navigate to another sheet. 

The word January is no displayed in A10 in all of the sheets. 

7. Reselect all sheets. 

8. Select cell A10 in this sheet and press delete on your keyboard.  

9. Navigate back to the sheet labeled ‘Summer 13’. 

Care should be taken when deleting information while all sheets are selected because the 

information will be deleted from all of the sheets 
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10. Ungroup the worksheets.  

This can be done by clicking any worksheet’s name besides the active worksheet. You can 

also right-click the name of any grouped sheet and choose ‘Ungroup Sheets’. 

 

As you can tell, grouping worksheets can save time by formatting multiple worksheets in 

the same way, but it also can delete data in multiple sheets.  

Transposing Table 

If you have a table, you can have Excel transpose it for you. What this means is that 

Excel will take the Rows and Columns of a table and flip them. This can be done using a 

pivot table; however, if you simply want to display the original table and the 

transposed table on the same sheet, this method can be faster. This method only works 

on tables which have not been formatted as a table, but any formatting can be removed 

so that the transposing can be done.  

1. Open the Sales_per_Person.xlsx worksheet. 

This sheet contains a table, which displays a fictitious “Quarterly Sale per Person” 

report. We will be transposing the table so that it displays the divisional sales per person.  

There is some formatting on the table, so we need to clear this before we move on. 
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2. Select the Table and navigate to the Design tab.  

 

 

3. Select ‘Convert to Range’ in the tools group.  

The table should now only have basic formatting.  
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4. Select and copy the entire table. 

5. Click into Cell A13 and paste the table using ‘ctrl+v’. 

This will paste an identical table to the one already in the sheet. We will be using paste 

options to transpose the new table here. 

6. Click the “Paste Options” drop-down menu at the bottom right-hand corner of 

the new table.  

This menu allows you to choose different types of pasting. We will see some more of these 

features later in the Advanced Formulas section. A list of options for special pasting is 

displayed by images depicting what each option does.
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7. Choose the Transpose option.  

This option is signified by the  button. You should now have two tables showing the 

same information in different ways.  

 

Though basic formatting features are useful, advanced formatting in Excel can save a lot 

of time when things need formatted in similar ways. Another feature in Excel that has 

more advanced aspects is formulas and functions.  

  



AT Computer Labs 

Advanced Formulas and Features 

In this section, we will be discussing the advanced tools, features, and formulas that 

Excel has to offer. Though some of the following features are not formulas or functions 

themselves, they are still useful, and can save time, when working with functions. We 

will first be exploring some techniques that allow you to easily work with formulas that 

were previously created, then we will see how range names help functions, and last, we 

will apply this knowledge in some advanced formulas that are contained in Excel. 

Formula Tools 

When working with formulas in Excel, it’s useful to know when a cell is used in a 

formula and what formula it is being used in. There are some keyboard shortcuts that 

can help us do this. In addition, you can format formulas so that others looking at the 

sheet can tell which cells contain information from a formula. There is also a trick to 

quickly populate a formula down a column. 

1. Open the Simple_Budget.xslsx worksheet. 

In this worksheet, there are some calculations that have not been labeled. Every cell in 

this sheet is either an output from a function or used in a function. 

2. Click into B2 and press ctrl +] on the keyboard. 

This will show us what cells contain functions that reference this cell. In this case, there 

are only two which are both in the screen, but if not, we can use enter to navigate to the 

other functions.  

 

3. Press enter to move to the second formula that uses this cell.  

4. Click into cell C13 and press ctrl + [on the keyboard. 

The active cell is now a cell that is used in the function which is located in C13. Pressing 

enter will also move between cells here similar to step 4. 
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5. Find what the data in B11:B15 and C12:C15 is referencing and label them using 

the closest empty cell. 

Cell B11 contains the total rent, so you could put “Total Rent” in cell A11. When 

labeling, notice that the all of the data in C12:C15 are averages. 

6. Navigate to sheet 2. 

In this sheet there are a list of tenants and some data about their rent. In D2, there is a 

formula for that tenants total rent, but we want this formula to be in the whole table. We 

could drag the formula through the table, but excel has a quicker method. 
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7. Select D2 and double click the small box in the bottom right hand corner of the 

cell. 

Notice the formula is now in column D for each row. 

We know want to add the entire column into G1. We could navigate to the bottom of the 

column and enter the range that has data, but if any tenants are adding to this list, their 

rent would not be included.  

 

8. Enter “=Sum(D:D)” into G1. 

This formula reads “sum the entire D column”. Using this notation, if any addition 

tenants are added to the list, they will be included in the formula. 
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9. Type”=average(“ into G2, select column B and press enter. 

Selecting the column is another way to specify that the values in the entire column will 

be used. 

Now that we have some formulas in this sheet, we will look at a few easy ways to display 

those formulas. Your sheet should look like the following picture: 

 

  



AT Computer Labs 

10. On the keyboard press ctrl + `.  

This shows all of the calculated formulas as functions. 

 

11. Press ctrl + ` again to return the values.  

12. In the editing group on the Home tab choose Find and Select. 
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13. Choose formulas from the menu. 

For easier viewing, one could format the formulas with shading. All of the cells 

containing formulas are now selected.  

 

14. Shade all of the formulas with a color. 

 

If you wanted to add to cells, but did not want to use a formula, special pasting can help. We 

want to add 6 months to every cell in column C. 

15. Type 6 in cell E1 and copy the cell. 
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16. Select column C and press ctrl + alt + v on the keyboard.  

This opens the special pasting dialog box. Some options are available on a right click, but 

we need more specific options. 

 

17. Choose Add and skip blanks, then click OK. 

This told Excel to add the copied value to all of the cells in this column. Notice the text 

data does not change.  

 

Suppose you wanted the data in column D to be displayed, but you did not want the 

formula contained in the sheet. Using special pasting, we can remove all of the formulas 

from column D. 
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18. Select and copy column D. 

19. Right click on column D. 

 

20. Choose the special pasting menu. 

This menu contains many different pasting options. If more options are needed, choosing 

Paste Special from here would bring up the special pasting dialog box which we saw 

earlier.  

21. Click on the values option. 

This option, , tells excel to only paste the values from the copied cells into the now 

selected cells.  

22. Click a few of the cells in column D to observe that the data is now simply a 

value.  

The downside to doing this is that if you edited the Number of months data, column D 

would not be updated. 
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We have just explored some time saving techniques to use with functions and formulas 

in Excel. The next subsection talks about how naming ranges can save time with 

referencing in functions.  

Range Names 

Sometimes when referencing cells in formulas, it can be more convenient to name the 

cell or range of cells. Naming data ranges adds meaning to formulas because others 

who are editing can see what the data, that a formula is referencing, is for. The first step 

to using a data range is to name it. Once a range is named, other cells or formulas the 

range will absolutely reference that range. This allows you to copy formulas without 

applying “$” in the range name. 

1. Open the file named Students_Grades.xlsx. 

This workbook has a list of names followed by the points they have received in the class. 

There is also a column labeled Class Grade. Here only the first student’s Class Grade is 

calculated. In cell F2, there is a seemingly random number. We want to designate this as 

the total possible points in the class so that we can use it to calculate the student’s final 

grades.  

2. Double click into cell D2. 

The cell uses relative referencing to divide the value from column C by the value in cell 

H2 and formatted to return a percent. If this formula was copied down column D, every 

cell besides D2 would return an error. We could fix this by using absolute referencing, 

but it is also fixed by naming the data in H2 and using this name in the formula. 

3. Press the escape key to move from cell D2 without editing it, and click into H2. 

4. Hover over the box to the left of the formula bar that displays ‘H2’. 

 

This is the name box where data ranges can be named. Clicking the down arrow on this 

box displays all the names that are used in this workbook. Since we do not have any 

names, the list is empty.  
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5. Click into the name box and type “Total_Points”. 

Names must not contain spaces nor start or end with a number; however, they can use 

underscores as well as capital letters. Here we used the underscore to separate the words, 

but capital letters at the beginning of words can do the same.  

6. Press enter to accept the name. 

Whenever H2 is the active cell, the name box will display ‘Total_Points’. Clicking the 

down arrow in the name box and selecting this name will also make F2 the active cell. 

 

7. In D2, change ‘H2’ to ‘Total_Points’ and press enter.  

When you start typing the cell’s name, it appears in the dropdown formula list as shown 

in the picture below. You can then use the down key and tab or double click the name to 

insert it into the formula. The formula now absolute references the named cell without 

using the ‘$’ in front of the name.  

8. Copy the formula through the rest of column D.  
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In addition to naming one cell, a range of cells can be named. This is useful if there are large 

ranges that need to be manipulated. In this sheet, there is a table displaying the class statistics, 

we will use range names to calculate these statistics. 

 

9. With Students_Grades.xlsx open, select column C and D. 

We want to use some functions on these data sets, but we don’t want to select the sets 

every time we use the data, so we will name the columns. 

10. Navigate to the Defined Names group in the Formulas tab and click Create from 

selection. 

A dialog box displaying different options for naming the columns is displayed. The ‘Top 

Row’ option is selected. This means the name of each column will be based on the data in 

the top cell of that column. 

     

11. Click ok. 

If you were to click into the name box now and select either of the names we just created, 

Excel would navigate to those ranges.  
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12. Type “=MIN(Class_Points_Earned)” into cell I2, “=MAX(Class_Points_Earned)” 

into cell J2, and “=AVERAGE(Class_Points_Earned)” into cell K2. 

Notice that Excel calculated this data from the cells in column C only taking cells with 

actual data into account.

 

13. Repeat the previous step for cells H3:J3 using the min, max, and average 

formulas respectively. 

A downside to using names is that when there are a lot of names in a workbook, 

knowing what those names are can become tricky. Now that we have a few different 

names in the workbook, we can look at how to manage the names. The names can be 

pasted into the sheet so that anyone using the sheet later knows what range the names 

are for. 

14. Click into cell G20. 

We want an area on the sheet that has a lot of space for the list to be placed. Our current 

list is not very long, but even if we had a longer list, this area would have enough space. 

15. Press F3 on the keyboard. 

A dialog box displaying the possible range names are listed. At the bottom left hand side 

of this box is a botton labeled ‘Paste List’.  
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16. Click ‘Paste List’.  

Our list of names is now put in one column and the location or range of cells that the 

name reference is placed in the column to the right of this list. This is a quick way for 

anyone who is using the worksheet in the future to see the names in the sheet; however, 

using the ‘Name Manager’ you can edit the names and add comments about the names. 

 

17. Navigate to the Formulas tab and click Name Manager. 

 

A dialog box displaying the names from this worksheet is shown. There are options to edit 

and delete selected names as well as the option to sort the list using column names and to 

filter through the list. There is also the option to redefine the cells that are named. Notice 

in the list of names, there is a section for comments. We want to add a comment to the 

cell named ‘Total_Points’. 
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18. Choose ‘Total_Points’ and click ‘Edit’. 

 

19. In the comments area type: “This is the total points possible in the class. Use it to 

find students overall class grade.” 

20. Click ‘Ok’ to save the comment.  

The comment is partially showed in the comment section, but for future viewers of the 

worksheet to see the whole comment, they too would have to choose the name and click 

‘Edit’. 

21. As practice, define “Letter_Grade_Table” as a name for cells G7:H18. 

We will use this name in the next subsection. 

  

Range names can add meaning to formulas and allow large sets of data to be manipulated 

without having to select the entire set each time it is used. 
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Lookup, If, and Time Functions 

Many functions in Excel do not simply perform calculations. One example is the 

vlookup function. Other functions, such as if functions perform calculations based on 

whether certain criteria are met, and other functions display or calculate based on dates 

and times. In this section, we will look at these functions and how to use them in a 

sheet.  

1. With Students_Grades.xlsx open, select E2.  

In this column, we want to display the respective letter grades based on the grade range 

found in the letter grade table. 

2. Type “=vlookup(“ 

This is the function that will look up a value an decide where it is on our table. The 

difference between the vlookup and the hlookup functions is the orientation of the table. In 

our sheet, the table is vertical, so we use vlookup, but if the table was horizontal, we 

would use hlookup. 

 

3. Select column D and type a comma. 

The first entry for this formula designates what will be evaluated. We want to return a 

letter grade based on the percent found in cell D2. 

4. Type “Letter_Grade_Table,”. 

This tells the function where to get the return data. Here, if data is greater than a value 

in the left column on the table, it returns the value from that row. 

5. Type “2)”. 

This tells Excel that the value returned will be from the second column in the table. If the 

table was horizontal, it would signify the second row. 
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6. On the keyboard press enter. 

In our case, the data is in ranges; however, if our data was meant to matchup exactly to 

the data in the table, we could specify that here. 

7. Copy the formula down the rest of the column. 

 

Just by looking at this table, it is unclear how successful this class as a whole was. We can use If 

functions to display how many of each letter grade was present in the class. We will input this 

information in the second column of the ‘Number of Each Letter’ table.  
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8. Click into K7. 

This is the cell where we want to display how many of each letter there is. 

 

9. Type “=countif(“ 

This formula has two arguments, a range and criteria. The range is simply where the data 

we are counting is located. The criteria designate what will be counted.  

10. Choose column E and type a comma. 

All of the letters that will be counted is in this column. 

11. Choose cell J7 and press ctrl + enter. 
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The criterion for this cell is that the letter is E. Since we want to be able to copy the 

formula and since the data is already displayed to the left, that cell is our criterion. 

12. Copy the formula through the rest of the table. 

 

 

We will now be opening a different workbook to use some more if functions. 
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13. Open Employee_Info.xlsx and choose the sheet labeled Status. 

On this sheet, there is a list of employees along with some pay info. There is also a table 

that is meant to display totals based on the employee’s status. We want to calculate the 

total salaries for each type of employee and place them in this table. The sumif function 

will help us do that. 

14. Type “=sumif(“ into J4. 

This function has three arguments. The first is the range where the if statement will look. 

The criteria is what the if statement is looking for in the first range, and the sum range is 

what will be added if the criteria is met.

 

15. Select Column F for the first entry and type a comma. 

Since we are summing the salaries of Full Time employees, we want the function to look 

in this column for that information. 

16. Type “ I4,”. 

If this information was not in the sheet, typing “Full Time” including the parenthesis 

would suffice. 

17. Last choose column D for the sum range.  
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18. Copy this formula into cell J5. 

Now that we know how to use the sumif function, we can fill out the rest of the table. 

 

19. Repeat these steps for the rest of this table using column E for the sum range. 

 

The average if function works similarly to the sumif and countif functions; however, the if 

function is slightly different, so we will learn about it now. In the sheet there is a Benefits 

column. We want to specify whether an employee gets benefits based on their employment status. 

20. In cell G2, type 

 

 

In this company, they want all employees except for contracted employees to have full benefits, so 

we are using the if function to test whether an employee is under contract or not. This function 

has three arguments. The first is a logic test where we put F2=”Contract”. Anytime Excel logic 

tests are looking for or returning text it is necessary to include the parenthesis. The second entry 

specifies the result if the logic test is true, and the third entry designates what to return if the 

logic test is false. If the logic test was comparing numbers, equal to, less than, less than or equal 

to, greater than, greater than or equal to, or not equal to could have been entered respectively as 

=, <, <=, >, >=, or <>. 
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21. Copy the function through the column. 

 

 

The last function type we are going to look at are time functions. These functions do things like 

displaying the current date or date and time. Times can also be incorporated into general 

functions.  

22. Navigate to the Time Worked worksheet. 

In this sheet there are is a list of employees along with their starting and projected ending 

dates. We will be calculating both how many months have been worked and how many 

months are projected to be worked per person. 

23. In cell E2, type “=datedif(“. 

 

This is a hidden function in Excel. If you search for it, you will not be able to find it, but 

it is still a useable function. There are three arguments in the formula which are: The first 

date, the date that the first date is being subtracted from, and how the result will be 

displayed. The possible choices for display are year (y), month (m), day (d), days since 

last full year (yd), months since last full year (ym), and days since last full month (md).  
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24. Select cell C2 and D2 typing a comma after each. 

This is telling excel where to find the dates used in the difference.  

 

25. Type “m” including the quotations and press enter. 

When the function is run, it displays the months. This function does not round, so if 

someone worked 29 days, the function would say that they worked 0 months. 
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26. Fill in the rest of the table with this function.

 

27. Select F2. 

We know want to display how many months have currently been worked. Since we don’t 

want to update this function every time we open the file, we will use a function that 

always relies on the current date. 

28. Type “=datedif(C2,today(), “m”)” and press enter on the keyboard. 

 

The today function returns the current date, so in this formula, Excel is subtracting the 

date in C2 from today’s date and displaying the number in months. This screenshot is 

from December 20th, 2012, so it makes sense that F2 is displaying a four with this 

formula. 
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29. Copy this formula through the table. 

 

If there are errors, it could be because the starting date is after the current date.. In this 

formula, it is important to keep to earliest date as the first argument. 

 

We have just looked through some advanced features and formulas that are useable in Excel. 

With some of these formulas, specific types of data must be used. The next section covers how to 

ensure that data is entered in a specific way. 
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Data Validation 

When multiple people are working on the same file, sometimes it is necessary for a cell 

to warn users that the data is not the correct type for that cell. Data validation allows 

you to designate a type of data for a cell. It also allows you to designate if Excel will 

block incorrect data or allow it and give a warning after the incorrect data has been 

entered. This can help keep forms neat by not allowing data which would cause errors 

in formulas.  

1. Open the Order_Form.xlsx workbook. 

In the first sheet in this book, we have an order form. We want the data entered into this 

form to be both realistic and coherent. To make sure this is done, we will restrict the type 

of data that can be placed in each column. 

2. Select Column A. 

In this column, we want to ensure that the only data entered is text.  

3. Navigate to the Data tab and click the Arrow that says ‘Data Validation’ in the 

Data Tools group. 

 

Three options are shown here. In the next step, we will look at the first option labeled 

‘Data Validation…’.  If a cell allows invalid data, using the ‘Circle Invalid Data’ allows 

you find that data easily, and ‘Clear Validation Circles’ clears the circles that have been 

placed around invalid data.  
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4. Choose ‘Data Validation…’. 

A dialog box is displayed with three tabs. In the first tab, you can choose the type of data 

to be entered in that cell. 

 

5. In the section labeled ‘Allow:’, choose ‘Text Length’. 

 

6. In the section labeled ‘Data:’, choose ‘less than’. 

We choose this option because we want the length to be less than 19 characters, but we 

are not concerned with the text length being too short. 
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7. Specify the max length to 19 characters. 

 

8. Navigate to the ‘Input message’ tab. 

This tab edits whether or not a message is displayed while one of the validated cells is 

active. 

 

9. In the title section, type “Last name, First name”. 

This is so that users of this sheet know to put the name in with their last name first.  

10. In the message section, type “Names may be at most 19 characters in length.” 

In some cases, names that are too long can cause problems such as when a name does not 

fit on a shipping label. 
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11. Click on the Error Alert Tab. 

This designates whether or not a user can enter invalid data as well as whether they will 

receive a message or not. 

 

12. Under style, select ‘stop’. 

This option will stop the user from saving invalid data in the sheet. They will also receive 

a message saying that they entered invalid data. 

13. For the error message, type ‘Names must be less than 19 characters.’ 

Since the general message does not specify why the data was entered incorrectly, we want 

to tell users what kind of data should be entered. 

14. Click ‘Ok’ to save the data validation. 
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15. Click into cell A2, type “Williamson, Jonathan” and press enter. 

 

Notice the input message is displayed here. This name is longer than 19 characters, so we 

will get an error message when we navigate away from this cell.  

 

16. Press Cancel to delete this name. 

If more control is needed, user’s data validation can cause anyone who edits this cell to select 

from a list of possible entries. 

17. Select Column B. 

We want to make sure any data in this column is from the list in column G.  

18. Open the Data Validation menu and choose ‘List’ in the allow section.  
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19. Choose cells G2:G18 for the source of the list. 

 

Notice the absolute referencing in the source field. If this data was moved anywhere in 

this workbook, the list in column B would remain the same; however, the list cannot be 

removed from the sheet. 

20. Click Ok and click into cell B2. 

Notice there is now a dropdown arrow next to this cell. 

 

21. Click on the dropdown arrow and choose one of the items. 

 



AT Computer Labs 

22. Fill in a few more cells in column B. 

For the next column, we want the list to be dependent on the data in the item column. 

Notice to the right of each item in column G is a list of sizes. Each item has a different list 

of sizes, so we are going to use a name range to create a list which will be dependent on 

the previous selection in the form. 

 

23. Select column C. 

24. Open the Data Validation window and select list.  

We won’t actually be choosing a list, but we will be entering a formula to tell excel where 

to find the name of the list. 
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25. Type “=indirect(B1)”. 

Since C1 is the active cell, this tells Excel to look to the cell to the left for the name of the 

list.  

 

26. Click ‘Ok’. 

 

An error message is shown asking if we want to proceed. 

27. Click ‘Yes’.  

28. Click on the dropdown arrow next to cell C1. 

At this point, we have not named the ranges that our list will come from, so there are no 

entries in our list and nothing happens. 
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29. Select Cells H2:T18. 

 

30. From this selection, define the range name based on the values in the left row. 

 

As we did before with range names, we are defining a list by the name to the left of the 

range. 
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31. Click on the drop down list in cell C2.  

 

Since we have defined a list to each name in column B, there are now options in the drop 

down list in column C. For most of these lists, there are blank entries, and the actual 

options cannot be seen without scrolling through the list. This is because with our set of 

data, there were blank entries in the rows. We can fix this by simply deleting the blank 

cells in our named ranges. 

32. Select cells H2:T18. 

We will be using a search function, but we only want to search within this range of data. 

33. Navigate to the editing group on the Home tab and choose Find and select. 
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34. Choose Go To special..., select blanks, and click ‘Ok’. 

 

This selects all of the blank cells in our selected range. With these cells selected, we can 

now delete them. 
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35. Now right click on a selected cell, choose delete, and shift cells left. 

 

Nothing actually changed on the sheet, but the blank cells are now removed from our 

named ranges. The ranges could have been made without having the blank cells; however, 

that would have involved selecting each row and naming the ranges individually. There 

should no longer be blank cells available to be selected in column. 

36. Click the dropdown arrow in cell C2 to check for blank entries. 

 

Because we do not want our lists to be on the same page as our order form, we can move it to 

another sheet.  
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37. Select cells G2:T18 and press ctrl + x on the keyboard. 

 

38. Click on sheet 2 and select cell A1. 

39. Press ctrl + v on the keyboard.  
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40. Return to sheet one and test some cells in columns C and B to check the data 

validation.

 

Another useful data restriction is the ability to use formulas to validate data. In our order form 

we do not want the ability for the order date to be before the current date. We will setup a 

formula using the TODAY() function in the data validation window.  

41. Select column F and open the data validation window.  

42. In the allow section, choose custom. 

If a time range restriction was required, or if the date was not dependent on the current 

date, the date option could be chosen here. Since the date that we want information 

entered after will change, we will have to use a formula.  
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43. In the formula section type “=F1>TODAY()-1”.  

This is telling Excel that the date in D1 must be greater than the current date minus one 

day. This way, we allow users to enter todays date in addition to any date after today. 

 

44. Press ok and try to enter todays date in the cell F2. 

Since the current date is included, we do not get an error for this data. 
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45. In cell F3 try to enter yesterday’s date. 

Since yesterday’s date is not greater than the current date minus one day, Excel returns 

an error. Now, if today’s date was entered and the document was reopened another day, 

we would not receive an error unless the cell was edited. This is because data validation 

only returns errors on data that is entered. 

 

 

As we have just seen, when it is important that data follow certain rules in a worksheet, data 

validation can ensure that this happens.  
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Conclusion 

This lesson went over many of the advanced features in Excel. We started with time-

saving interface customization features which included the ability to add a tab in the 

ribbon, customize the status bar, navigate in multiple files simultaneously using 

multiple windows, and use static columns or rows. We then looked at how referencing 

across sheets. This lead to advanced formatting features which were creating custom 

lists, using groups to format over multiple worksheets and transposing tables. The 

advanced formulas section explored different formula tools as well as the use of range 

names in formulas. We used some of these tools and range names to create various 

advanced functions. Last we looked at how Excel allows us to block incorrect data using 

data validation.  With this information, you can now use Excel efficiently and 

confidently.  

 

For additional information regarding Excel, including live videos, consult Lynda.com 

which is free to all University of Florida students and staff.  
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Advanced Excel Activity 

This activity is here to allow you to practice the features we have discussed in this 

lesson. It will require you to populate new data into sheets, so you can use random 

number generators to get that data.  

Using the Units_per_Customer.xlsx exercise use what you have learned in this lesson to 

complete the following tasks: 

 Create a new tab and place it between the Insert and page layout tabs. 

o Create two groups and place 3 tools in each group 

 Save a workspace that displays sheet 1 and sheet 2 side by side 

 In sheet 2, reference a cell with data from sheet 1 

 Create a custom list from 10 of the last names in column A 

Create a new worksheet to complete the following tasks: 

 Format 5 sheets to have a table with a name column. 

 Populate your custom name list into the name column 

 Create the data and use a lookup and if function. 

 Using the today function, place the current date in a cell 

 Apply data validation to three of your columns. 
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